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Desktop Tools 

Summary of Desktop Tools 
The Desktop Tools palette is the main tool palette for the software. All other tool palettes and 
software features can be accessed from Desktop Tools. 
 
 
 
 

 
 

Pen Annotation 
 

 
 
Selecting the Pen tool allows you to annotate your desktop and causes the Desktop Tools palette 
to change to the Desktop Annotation Tools palette. 
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Start PowerPoint Presentation 
 

 
 
Selecting Start PowerPoint Presentation opens the Windows File > Open dialog so you can 
browse your files and select a PowerPoint presentation to open.  
 

On-Screen Keyboard and Handwriting Recognition Tools 
The On-Screen Keyboard Tool and Handwriting Recognition Toggle Tool are grouped into a 
single sub-menu on the Desktop Tools palette. 
 

 

On-Screen Keyboard Tool  

  
 
 Selecting On-Screen Keyboard opens the Windows On-Screen Keyboard that you can use to 
enter text by tapping keys with the Interactive Stylus. You can change the font and font size on 
the keyboard by selecting Settings > Font. You can close the On-Screen Keyboard by selecting 
the On-Screen Keyboard button again or selecting the close (X) button on the On-Screen 
Keyboard.  
 

Handwriting Recognition Toggle Tool 

  
 
Toggles the Handwriting Recognition package on and off. Handwriting Recognition is used to 
convert Interactive Stylus annotations into text that can be used in Text Boxes and dialog boxes. 
Interact software specifically works with ritePen® version 2.5 or later or MyScript® Stylus 
version 2.6 or later.  
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Options 
 

 
 
Selecting Options from the Desktop Tools palette launches the Options dialog box. The 
Options dialog allows you to set the following setup options and preferences: 
 

• The General tab in the Options dialog allows you to set the appearance and behavior for 
all of the Interactive Tool palettes.  

 
• The Annotations tab in the Options dialog allows you to set behavior for how desktop 

and PowerPoint annotations are saved.  
 

Mouse 

 
 
The Desktop Mouse Tool switches you from annotating your desktop to navigating your 
desktop. The Mouse Tool remains selected until a different tool from the Desktop Tool palette 
is selected. 
 

Snapshot and Recorder Tools 

 
 
The Snapshot Tool and Recorder Tool are grouped into a single sub-menu on the Desktop 
Tools palette.  
 
Snapshot allows you to take a picture of the current screen and save it into Scrapbook either as a 
background image in a new Page or a Scrapbook element in the current Page.  
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Use Recorder to record everything that happens on your desktop including voice tracks from 
your computer’s microphone. Play back your recording instantly in our Movie Player if you save 
the recording in the default *.ebm format. Or save your recording as an .avi, .swf or .wmv movie.  

Scrapbook 

 
 
Selecting Scrapbook launches the eBeam Scrapbook application.  

Calibrate 

 
 
Selecting Calibrate starts the interactive calibration process. You will be prompted to perform a 
9-point calibration. You can also start Calibration from the Calibrate Interactive Area... menu 
item in the Windows Taskbar menu. Carefully tap the center of the red targets with your 
interactive stylus to successfully calibrate. 
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Desktop Annotation Tools 

Summary of Desktop Annotation Tools 
 

 
 
The Desktop Annotation Tools appear when you select Annotate Your Desktop. The Desktop 
Annotation Tool palette gives you all of the tools you will need to annotate your desktop. 
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When you select Desktop Annotation, a snapshot is taken of your desktop at that moment and 
turned into an image that you can write on. A translucent frame appears around the border of the 
screen to indicate that you are annotating the desktop image and not navigating your desktop.  
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Pen Tool 

 
 
The Pen Tool allows you annotate the desktop freehand.  
 
When the Pen Tool is selected, the Pen Tool button becomes highlighted and the center of the 
Desktop Annotation Tool palette changes to show the current color and line width settings. 
 

Shapes Tool 

 
 
The Shapes Tool allows you draw shapes on your desktop.  
 
When the Shapes Tool is selected, the Shapes Tool button becomes highlighted and the center 
of the Desktop Annotation Tool palette changes to show the current color and line width 
settings.  
  

Redo Tool 

 
 
The Redo Tool allows you to redo the last undone annotation, provided you had previously used 
the Undo Tool. If you have used Undo multiple times, you can redo the changes back to the 
beginning of the series. Redo is disabled once a new annotation occurs.  
 

Eraser Tool 

 
 
The Eraser Tool allows you to erase desktop annotation marks made using the Desktop 
Annotation Tool palette.  
 
When the Eraser Tool is selected, the Eraser Tool button becomes highlighted and the center of 
the Desktop Annotation Tools palette changes to show the current eraser thickness setting. 
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Mouse Tool 

 
 
The Desktop Mouse Tool switches you from annotating your desktop to navigating your 
desktop. It also changes the Desktop Annotation Tools palette to the Desktop Tools palette. 
 

Save and Recorder Tools 

 
 
The Save Tool and Recorder Tool are grouped into a single sub-menu on the Desktop 
Annotation Tools palette. 
 
Use Recorder to record everything that happens on your desktop including voice tracks from 
your computer’s microphone. Play back your recording instantly in our Movie Player if you save 
the recording in the default *.ebm format. Or save your recording as an .avi, .swf or .wmv movie.  
 
The Save Tool allows you to save a snapshot of the annotated desktop into Scrapbook as a new 
Page. As the new Page is being saved, a save icon will appear on your desktop. You must save 
the Scrapbook file if you want to keep the Page permanently. 
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Undo Tool 

 
 
Undo erases the previous annotation. It is possible to select Undo multiple times until the page is 
blank. 
 

Highlighter Tool 

 
 
The Highlighter Tool allows you annotate the desktop freehand.  
 
When the Highlighter Tool is selected, the Highlighter Tool button becomes highlighted and the 
center of the Desktop Annotation Tools palette changes to show the current color and line 
width settings.  
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Scrapbook 

 
 
eBeam Scrapbook is a digital repository for all your handwritten notes, drawings, image files, 
and Microsoft Office documents.  

Four Scrapbook View Options 

Page and Thumbnails View 
When the Page and Thumbnails View is selected, a scrollable column of Thumbnails is 
displayed on the left side of the Scrapbook window, while one full Page is displayed on the right 
side of the Scrapbook window. Features of the Page and Thumbnails View include: 

• Scrollable column of Thumbnails for viewing all Pages included in the Scrapbook 
meeting. 

• Drag and drop page reordering. 
• Sizable Thumbnails column. Resize by dragging the boundary between the Thumbnails 

and the Page. 
• Click on any Thumbnail to display its large view as the Page on the right side of the 

Scrapbook window. 
• Drag and drop elements from Page onto a thumbnail. 
• Page Selection tools in the Scrapbook Toolbar. 
• Meeting file playback. (Page and Thumbnails View or Page View only). 
• Background Image import into the displayed Page. 
• Page annotation using Scrapbook Tools or the standard annotation toolbar. 
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Thumbnails View 
When the Thumbnails View is selected, only Thumbnails are displayed in the Scrapbook 
window. The Thumbnails View is very useful for giving you a summary of the pages in your 
meeting and allowing you to find individual pages rapidly. Features of the Thumbnails View 
include: 

• Scrollable column of Thumbnails for viewing all Pages included in the Scrapbook 
meeting. 

• Drag and drop page reordering. 
• Instantly display Thumbnail in Page View with a Double-tap (Interactive Stylus) or 

double-click (mouse). 
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Page View 
When the Page View is selected, only a single Page is displayed in the Scrapbook window. 
Features of the Page View include: 

• Page Selection tools in the Scrapbook Toolbar. 
• Annotate within the Page. 
• Background Image import into the displayed Page. 
• Page menu options for adding a new page, duplicating a page, or deleting a page. 

 

 



eBeam Interactive Tools User Guide 

 

eBeam Building Blocks Course Manual  page 16 
 

Full Screen View 
Full screen view maximizes the current page to full screen size. The Scrapbook Toolbar becomes 
a floating toolbar that can be closed and the Scrapbook Tool palette becomes the Scrapbook Full 
Screen Tool palette. 
 
Working in Scrapbook's Full Screen View gives you the ability to present Scrapbook meeting 
Pages in the same way that you would present a MS PowerPoint slide show, except that you have 
the access to all of the useful presentation features found in Scrapbook.  
 
Useful features include: 

• Import, rotate, resize image elements while giving your presentation. 
• Annotate within the Page. 
• Add new Pages to the presentation. 
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Scrapbook Tools 

Summary of Scrapbook Tools 
 
There are two flavors of tool palettes in Scrapbook. The Scrapbook Tools Palette and the Full 
Screen Tools Palette: 
 
Scrapbook Tools Palette 
 

 
 
Full Screen Tools Palette 
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Scrapbook Tools appear when Scrapbook is the active window. The Scrapbook Tools palette 
gives you all of the tools you need to create Page content. 
 
While working in Full Screen View, the Scrapbook Tools palette switches to a presentation-
based focus, displaying the Slide Forward and Slide Back tools.  
 
Please note the following important points: 
 

• If you select anywhere outside the Scrapbook window, the Scrapbook Tools palette will 
change to the Desktop Tools palette. 

• When you switch to the Full Screen View, the Scrapbook Tools palette switches to a 
Scrapbook Full Screen Tool palette. 

Pen Tool 

 
 
The Pen Tool allows you annotate the displayed Page freehand.  
 
When the Pen Tool is selected, the Pen Tool button becomes highlighted and the center of the 
Scrapbook Tool palette changes to show the current color and line width. 
 

Text and Shapes Tools 

 
 
The Text Tool and Shapes Tool are grouped into a single sub-menu on the Scrapbook Tools 
palette.  
 
The Text Tool allows you to add a text box to the displayed Page. When the Text Tool is 
selected, the Text Tool button becomes highlighted and the center of the Scrapbook Tools palette 
displays the Text Tool.  
 
The Shapes Tool allows you draw shapes in Scrapbook. When the Shapes Tool is selected, the 
Shapes Tool button becomes highlighted and the center of the Scrapbook Tools palette changes 
to show the current color and line width settings.  
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On-Screen Keyboard and Handwriting Recognition Tools 

 
 
The On-Screen Keyboard Tool and Handwriting Recognition Toggle Tool are grouped into a 
single sub-menu on the Scrapbook Tools palette. In Full Screen View, the Slide Forward Tool 
is included in the sub-menu. 
 
Selecting On-Screen Keyboard opens the Windows On-Screen Keyboard that you can use to 
enter text by tapping keys with the Interactive Stylus. You can change the font and font size on 
the keyboard by selecting Settings > Font. You can close the On-Screen Keyboard by selecting 
the On-Screen Keyboard button again or selecting the close (X) button on the On-Screen 
Keyboard.  
 
Selecting the Handwriting Recognition Toggle Tool toggles the Handwriting Recognition 
package on and off. Handwriting Recognition is used to convert Interactive Stylus annotations 
into text that can be used in Text Boxes and dialog boxes. Interact software specifically works 
with ritePen® version 2.5 or later or MyScript® Stylus version 2.6 or later.  
 

Slide Forward Tool 

 
 
The Slide Forward Tool allows you to move to the next Page in the Scrapbook meeting. This 
tool is available only from the Scrapbook Full Screen Tools palette. See Full Screen View for 
more information. This tool is disabled when you are on the last page in the Scrapbook meeting. 
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Eraser Tool 

 
 
The Scrapbook Eraser Tool allows you to slice an annotation element on a Scrapbook Page into 
two separate Scrapbook elements. Annotation elements are pen or highlighter lines created using 
the Pen Tool or the Highlighter Tool. 
 
Annotation elements that have been sliced into two elements are automatically grouped so they 
appear to still be a single element. To ungroup, select the element using the Select Tool, and 
choose Edit > Ungroup. It is now possible to use the Select Tool to move, resize, or rotate each 
element separately. 
 
When the Eraser Tool is selected, the Eraser Tool button becomes highlighted and the center of 
the Scrapbook Tool palette changes to show the current eraser thickness.  
 

Select and Pointer Tools 

 
 
The Select Tool and Pointer Tool are grouped into a single sub-menu on the Scrapbook Tools 
palette. 
 
The Select Tool allows you select a Scrapbook element on a Page to move, rotate, resize, group, 
or copy. To select a Scrapbook element tap the element. Once selected, handles will appear on 
the element. 
 
The Select Tool can also be used to draw a bounding rectangle around a group of elements to 
manipulate the entire group of elements at one time. 
 
The Pointer Tool allows each participant in a meeting to point to data anywhere within the 
meeting window. Each participant's pointer is displayed in a different color. 
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Note: The Pointer Tool is enabled only during a shared meeting. When the Pointer Tool is 
selected, the Pointer Tool button becomes highlighted and the center of the Scrapbook Tools 
palette displays the pointer logo.  
 

Snapshot, New Page, and Recorder Tools 

 
 
The Snapshot Tool, New Page Tool, and Recorder Tool are grouped into a single sub-menu on 
the Scrapbook Tools palette. 
 
Snapshot allows you to take a picture of the current screen and save it into Scrapbook either as a 
background image in a new Page or a Scrapbook element in the current Page. 
 
Use Recorder to record everything that happens on your desktop including voice tracks from 
your computer’s microphone. Play back your recording instantly in our Movie Player if you save 
the recording in the default *.ebm format. Or save your recording as an .avi, .swf or .wmv movie.  
 
The New Page Tool creates a new blank page in the Scrapbook meeting. The new page is 
inserted directly after the displayed page. 
 

Zoom Tool 

 
 
The Zoom Tool allows you to zoom into or out of the Page displayed in Scrapbook. When the 
Zoom Tool is selected, the Zoom Tool button becomes highlighted and the center of the 
Scrapbook Tools palette changes to show the zoom logo. 
 

Slide Back Tool 
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The Slide Back Tool allows you to move to the previous page in the Scrapbook meeting. This 
tool is available only from the Scrapbook Full Screen Tool palette.  
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Highlighter Tool 

 
 
The Highlighter Tool allows you to annotate the displayed page freehand.  
 
When the Highlighter Tool is selected, the Highlighter Tool button becomes highlighted and the 
center of the Scrapbook Tools palette changes to show the current color and line width.  
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Background Settings 
Background Settings allow you to set a color, image or document as the background for any 
Scrapbook Page.  
 
To open the Scrapbook Background Settings dialog box, go to Page > Background Settings in 
the Scrapbook window.  

Supported file formats for Background Settings 
• Bitmap (*.bmp) 
• Graphic Files (*.gif, *.jpg, *.tif, *.ico, *.emf, *.wmf) 
• Excel Spreadsheets (*.xls).  
• PowerPoint Presentations (*.ppt).  
• Word Document (*.doc, *.rtf).  
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Gallery 

Gallery Overview 
With Scrapbook's Gallery, you can quickly add graphics and photographs as Scrapbook 
Elements or as Scrapbook Page Backgrounds. Scrapbook's Gallery includes a centralized image 
directory used to organize multiple image directories located on your PC or on your network. It 
also includes a place to store and reference Favorite images, Templates, and a search capability 
that accesses Flickr online.  
 

 

Sample Folder 
The Gallery installs by default with a complimentary clip-art library included in the Sample 
Folder so you can begin working with the Gallery immediately. You can add Links to Folders in 
the Gallery that point to folders and directories elsewhere on your computer or on your network. 
This makes it easier for you to work with a much wider range of images than those included in 
the Sample Folder.  

Favorites Folder 
Using the Favorites folder, you can store thumbnail short-cuts to any number of images you need 
to reference repeatedly when working on Scrapbook pages.  
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Templates Folder 
If you have certain page layouts that you use often, you will want to leverage the Templates 
folder. You can create and store numerous template pages containing backgrounds and page 
elements. When it comes time to put together a presentation, starting out with a template can 
save you time.  

Flickr Search 
If you have internet access, you can use the Gallery’s Flickr feature. With our Flickr search 
capability, you can easily search the virtually limitless body of photographs stored on 
www.flickr.com. Just type any search term into the Gallery’s Flickr search field and any image 
with that tag will be imported into the Gallery for you to use in Scrapbook. 
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Accessing the Gallery 

To open the Gallery 
You can open the Gallery several ways:  
 

1. From the Scrapbook menu, select View, then Gallery.  
 

 
 

2. Or press Ctrl+4 on your keyboard (note: Ctrl + the number 4, not F4).  
3. Or select the Gallery button from the Scrapbook Toolbar.  

 

 
The Gallery directory tree, toolbar, preview pane and options toolbar display on the right side of 
the Scrapbook window.  
 
Note: You can resize the height and width of the Gallery panels to enlarge the Preview Pane.  
 
After opening the Gallery, you will see it on the right side of the Scrapbook window. The upper 
right area displays the Gallery directory tree, including all directories linked to the Gallery. Each 
directory (Gallery, Favorites, Templates and Flickr) is visible and can be accessed through the 
upper right area. 
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Gallery Directory Tree 
Scrapbook includes a Gallery directory named Sample. If you expand the Sample directory, you 
will see a number of sub-directories with various categories of clip art available.  
 

                                 
 

Gallery Toolbar 
Beneath the Gallery Directory Tree is the Gallery Toolbar.  
 

 
 
The Gallery Toolbar contains (from left to right) the Add Folder (or Add Link to Folder), Delete 
Folder (or Remove Link to Folder), Add as Background, and Add as Object buttons.  

Preview Pane 
The Preview Pane displays the image files contained in the directory you have selected in the 
Gallery Directory Tree including Favorites, Templates and Flickr. The Gallery is compatible 
with the following image file types:  
 
Bitmap (*.bmp) 
Graphic Files (*.gif, *.jpg, *.ico, *.emf, *.wmf, *.png) 
Flash Movies (*.swf, *.flv) 
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Gallery Options 
You can set the image view options for the Preview Pane using the Gallery Options toolbar. 
These toolbar settings apply to any images you are currently viewing in the Preview Pane.  
 

 
 
If you select the Show Thumbnails icon (the first button on the left), the Preview Pane displays 
the images as thumbnails. If you select the Show List icon (the second button from the left), the 
Preview Pane displays the images as a list of filenames including a very small file type icon as a 
scrolling list.  
 
Use the thumbnail size slider bar to reduce or enlarge the size of the thumbnail images. The 
slider bar is not visible when you have selected the List view.  
 

Adding Images to Scrapbook Pages 
You can import an image from the Gallery into a Scrapbook Page either as a Scrapbook Element 
or as a Background Image. If you import an object as a Scrapbook Element, then you can later 
move, rotate, resize, copy/paste, and edit the object within the Scrapbook Page. If you import an 
object as a Background Image, then the image is imported into the background of the selected 
Scrapbook Page and cannot be edited the same way you can edit a Scrapbook Element. 
However, you can modify certain aspects of the Background Image's appearance through the 
Background Settings.  

To add an image as a Scrapbook Element 
1. Select a Scrapbook Page. 
2. Search for an image using the Gallery Folders, the Favorites Folder(s) or the Flickr 

search capability.  
3. Once you have located the image you want to use, select it in the Preview Pane. 
4. Use one of the following methods to add the image to the Scrapbook page: 

a. With the image selected in the Preview Pane, select the Add as Object button 
from the Gallery Toolbar.  

 
b. Or drag-and-drop the object from the Preview Pane onto the Scrapbook Page.  
c. Or double-click the object in the Preview Pane.  

 
The object displays on the Scrapbook Page as a Scrapbook Element (with handles for 
manipulating the object).  
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To add an image as a Scrapbook Page Background 
1. Select a Scrapbook Page. 
2. Select an image using the Gallery Directory Tree and Preview Pane.  
3. With the image selected in the Preview Pane, select the Add as Background button from 

the Gallery Toolbar. 
 

 
The object is now shown on the Scrapbook Page as a background. The background image has a 
default scale setting of Scale Proportionally. To change this setting, select the Page menu, then 
Background Settings. In the Background Settings dialog, select a scale setting from the Options 
section of the dialog.  
 

Adding and Removing Links to Folders 
For your convenience and ease of access, you can add any directory that your computer can 
access to the Gallery Directory Tree. You can name it anything you like and link it to any 
directory that your computer can access.  
 
To Add a Link to a Folder 

1. With the Gallery folder selected, select the Add Link to Folder button.  
 

 
 
The Add Link to Folder dialog box opens. 
 

2. Fill in the name for the folder you want to create and see in the Gallery's directory tree. 
You are free to name this anything you like. It does not have to match the folder name 
used on your computer.  

3. Select the Browse... button. The Browse for Folder dialog box opens. 
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4. Navigate to the directory you'd like to add and select it.  
5. Select OK. If you select a Folder from your File Directory, the Folder name will be auto-

filled with the Folder’s name and the Folder Location field will automatically show the 
path.  

6. Select OK in the Add Link to Folder dialog box. The link to a folder you created is now 
shown in the Gallery Directory Tree. 

7. Select your newly created link name to see its images in the Gallery Preview Pane.  
 
To Remove a Link to a Folder 

1. Select the folder you want to remove from the Gallery Directory Tree.  
2. Select the Remove Link to Folder button.  

 

 
 
The Remove Link to Folder confirmation window displays.  
 

3. Select Remove. The folder is removed from the Gallery Directory Tree.  
 
Note: This does not delete the folder itself from your computer or network, it deletes only 
the link to the folder in the Gallery Directory Tree.  
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What is a Meeting? 
A meeting is a collection of notes and images stored as elements in Scrapbook Pages in a 
Scrapbook meeting file (*.esb). Scrapbook allows one meeting at a time to be open. 
 
A single meeting may have one or more participants who are sitting in one room using the 
interactive system to capture notes and diagrams.  
 
A single meeting may also have participants who are located in other locations, such as another 
floor in your building, another state, or even another country. This process of having participants 
attend your meeting over the Internet/intranet in real time is called Sharing a Meeting. 
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Hosting a Meeting 
 
Choose Meetings > Share Meeting or select the Share Meeting button from the Scrapbook 
Toolbar : 
 

 
 
The Share Meeting dialog will open:  
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Under Meeting Information, enter the following:  
 
Meeting Name - The meeting name is the name shown in the Join Meeting dialog box. The 
meeting name is saved as the default name for subsequent meetings, until you change it. The 
meeting name can be up to 20 characters. 
 
My Name - The name displayed in the Participants View. See Participants. 
Notes - Any notes/comment you would like to include. 
  
Publish Meeting Name - Select Publish Meeting Name if you want the name of the meeting to 
be visible to network users who are attempting to join a meeting using either the Join Meeting 
(see Joining a Meeting for more information) dialog box, or the Meetings web page located at 
www.e-beam.com. 
 
If you do not publish the name, guests will need to know the full meeting name beforehand and 
manually type it into the Join Meeting dialog box. 
  
Password/Confirm/Use Password - If a password is required, check the Use Password 
checkbox and type the same password into both the Password and Confirm text boxes. 
 
The password must be at least 6 characters, and can be up to 20 characters. 
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Send Meeting Invitation - Meeting invitations are e-mail invitations that are sent out using your 
standard e-mail client. If Send Meeting Invitation is checked, the Send Invitation dialog box 
opens once you select the Share Meeting button. See Sending an Invitation for more information. 
  
Archive Meeting on the Server -  An archived meeting allows you to search for, view, 
download, edit, and/or delete your archived meeting (based on the archive privileges you select). 
If Archive Meeting on the Server is checked, the Archive Meeting dialog opens after you select 
the Share Meeting button. See Archive a Meeting for more information. 
  
Synchronize Participants Immediately - Causes remote participants to be synchronized from 
the start of the meeting. Synchronize is on by default. See Participants. 
  
Deny access to remote participants with mismatched software versions -  The version of 
software you are using is not fully compatible with previous versions. During a shared meeting, 
participants running previous versions may not be able to see imported image files and will not 
be able to see when annotation or image elements are moved, rotated, resized, etc. Selecting 
Deny access to remote participants with mismatched software versions will only allow 
participants using the same software version or later to join your meeting. 
  

Once the information is entered, click Share to start the meeting.
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Joining a Meeting 
 

Choose Meetings > Join Meeting or select the Join Meeting button from the Scrapbook Toolbar: 

 

 
 

The Join Meeting dialog will open: 
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In the Join Meeting dialog box, select the meeting server, enter your name, and select a meeting 
name from the Meeting list.  

The Meeting list shows active meetings whose names have been published. If the pull-down 
menu does not include the meeting server you want, you can manually type the server name. 
Select Refresh to update the list of published meetings.  

If the meeting appears with a Lock icon, enter the password.  

If the meeting is not listed, enter the meeting name, and a password if required. 

Select Join.  

To leave a meeting, choose Meetings > Leave Meeting From…, or select the Leave Meeting 
button from the Scrapbook Toolbar. 
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PowerPoint Presentations 
 
When you select the PowerPoint icon on the Desktop Tools Palette, your file directory will open 
and you can select any PowerPoint presentation that you have saved. The presentation will 
launch in Slide Show mode and the tool palette will change into the PowerPoint tools palette.  
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PowerPoint Tools Palette 

 

 

Pen Tool 

 
 
The Pen Tool allows you annotate the displayed Page freehand.  
 
When the Pen Tool is selected, the Pen Tool button becomes highlighted and the center of the 
PowerPoint Tool palette changes to show the current color and line width. 
 

Shapes Tools 

 
 
The Shapes Tool allows you draw shapes on the PowerPoint slide. When the Shapes Tool is 
selected, the Shapes Tool button becomes highlighted and the center of the PowerPoint Tools 
palette changes to show the current color and line width settings.  
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Slide Forward Tool 

 
 
The Slide Forward Tool allows you to move to the next Page in the PowerPoint presentation. 
This tool is disabled when you are on the last page in the PowerPoint presentation. 
 

Eraser Tool 

 
 
The PowerPoint Eraser Tool allows you to delete an annotation element on a PowerPoint slide.  
Annotation elements are pen or highlighter lines created using the Pen Tool or the Highlighter 
Tool. 
 

Mouse Tool 

 
 
The PowerPoint Mouse Tool changes your stylus back to mouse functionality, so you can just 
click on a slide to forward the presentation. 
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Stop PowerPoint Presentation and Screen Record Tools 

 
 
The Stop PowerPoint Presentation Tool and Screen Record Tool are grouped into a single 
sub-menu on the PowerPoint Tools palette. 
 
Stop PowerPoint Presentation exits Slide Show mode and puts you back into PowerPoint Edit 
mode.  
 
Use the Screen Record Tool to record everything that happens on your desktop including voice 
tracks from your computer’s microphone. Play back your recording instantly in our Movie Player 
if you save the recording in the default *.ebm format. Or save your recording as an .avi, .swf or 
.wmv movie.  
 

Slide Back Tool 

 
 
The Slide Back Tool allows you to move to the previous slide in the PowerPoint presentation.  

Highlighter Tool 

 
 
The Highlighter Tool allows you to annotate the displayed page freehand.  
 
When the Highlighter Tool is selected, the Highlighter Tool button becomes highlighted and the 
center of the PowerPoint Tools palette changes to show the current color and line width.  
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Saving Annotations 
 
Once you’ve completed your presentation, click the Stop PowerPoint Presentation icon. Go to 
the File menu in the PowerPoint window and choose either “Save” or “Save As…” from the list 
to save your annotations to the .PPT file. 

 
 


